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ELECTRONIC AUCTION RESOURCES

HOW TO MONITOR THE FCC AUCTIONS ON-LINE

The auction announcements and round results for Auction 18 will be accessible through the FCC
Wide Area Network, the Internet and the FCC Auction Bulletin Board System (BBS).  You can
check on round results and also read any material released by the Commission during the course
of the auction.  This fact sheet provides the information that you need to track the auction from
your computer. 

Option 1: Tracking the Auction via the FCC Wide Area Network

The FCC has implemented a Remote Access System that allows up to 500 concurrent users to
dial in directly to the FCC to view round results, auction announcements, and messages, and to
make suggestions to the FCC regarding the FCC auction process.  

The following minimum hardware and software is required to use the FCC Remote Access
System:

Minimum Hardware Requirements

o CPU: Intel Pentium
o RAM: 16 MB 
o Modem:  v.32bis 14.4kbps Hayes compatible modem or faster
o Monitor:  VGA or above
o Mouse or other pointing device

For applicants using Microsoft Windows 3.1x:

o Hard Disk:   10 MB available disk space to install the FCC Auctions PPP Dialer

Minimum Software Requirements 

o Operating System: Microsoft Windows 95 or Microsoft Windows 3.1x
o PPP Dialer:

For Windows 95: Use the Dial-Up Networking feature included with
Windows 95

For Windows 3.1x: Use the FCC Auctions PPP Dialer available for download
on the FCC Internet Site and the FCC Bulletin Board
System



o Web Browser:
Netscape Navigator 3.01 or higher

or
Microsoft Internet Explorer 3.02 with the file-upload add-on or higher

Note:  If you are running Windows in a networked environment, check with your local network
administrator for any potential conflicts with the FCC Auctions PPP Dialer.  This usually includes
any TCP/IP installed network protocol.  

Note:  Throughout these instructions, “enter” means to type the appropriate information and then
press the ENTER key.

Connecting to the FCC Network

To use the FCC Remote Access System, you must first connect to the FCC Network using a PPP
(Point-to-Point Protocol) Dialer. The following PPP Dialer options are available: 

For Windows 95: Use the Dial-Up Networking feature included with Windows 95

For Windows 3.1x: Use the FCC Auctions PPP Dialer available for download on the
FCC’s Internet Site or FCC Auction Bulletin Board System 

The PPP Dialer connects to a 900 number telephone service at a charge of $2.30 per minute.  The
first minute of connection time to the 900 number service is at no charge. 

The PPP Dialer establishes a point-to-point connection from your PC to the FCC Network.  This
point-to-point connection is not routed through the Internet.

For instructions regarding how to connect to the FCC Network using Dial-Up Networking in
Windows 95, see the Accessing the FCC Network Using Windows 95 section.

For instructions regarding how to connect to the FCC Network with the FCC Auctions PPP
Dialer in Microsoft Windows 3.1x, see the Accessing the FCC Network Using Windows 3.1x
section. 

Using the FCC Remote Access System

After you have connected to the FCC Network, start your Web browser.  In your browser’s
Location field (Netscape 3.x), Netsite field (Netscape 4.x), or Address field (Internet Explorer),
enter the appropriate Universal Resource Locator (URL) as follows:

C http://wtbwww03.fcc.gov 

When you have finished, exit the Web browser, then disconnect from the FCC Network.



Help

For technical assistance with installing or using FCC software, contact the FCC Technical
Support Hotline at (202) 414-1250 (V) or (202) 414-1255 (TTY).  The FCC Technical Support
Hotline is generally available Monday through Friday, from 8 a.m. to 6 p.m. ET.  In addition, it
will be available from 9 a.m. to 5 p.m. ET, the weekend of August 15-16, 1998.  All calls to the
FCC Technical Support Hotline are recorded.

Option 2: Tracking the Auction via the Internet

You may use your Web browser to download announcements and round results from
wtbwww01.fcc.gov or www.fcc.gov as described in the following section.

Downloading from wtbwww01.fcc.gov:

1. Connect to your Internet service provider and start your Web browser.

2. In the Location field (Netscape 3.x), Netsite field (Netscape 4.x), or Address field
(Internet Explorer) of the web browser screen, enter the following location: 
http://wtbwww01.fcc.gov

3. a. Click on Auction 18.
b. For auction announcements, click on Announcements.
    For auction round results, click on Results.

4. Click on the file you wish to download.

Downloading from www.fcc.gov:

1. Connect to your Internet service provider and start your Web browser.

2. In the Location field (Netscape 3.x), Netsite field (Netscape 4.x), or Address field
(Internet Explorer) of the web browser screen, enter the following location: 
http://www.fcc.gov

3. a. Click on Auctions.
b. In the Auctions section on the right, click on 220 MHZ under In Progress.
c. Click on Data(Round Results), Announcements.
d. For auction announcements, click on Announcements.
    For auction round results, click on 220 MHZ Auction Round Results.

4. Click on the file you wish to download.



Archive Directories

The FCC will establish archive directories for round results files on the Internet.  After every 50
rounds, files will be moved from the Results directory to an archive directory. The newest round
results files will continue to be uploaded to the Results directory.

For example, in round 102, round results files would be located as follows:

On wtbwww01.fcc.gov:

Rounds 1-50 pub/220_MHZ/Auction_18/Results/R001-050
Rounds 51-100     pub/220_MHZ/Auction_18/Results/R051-100
Rounds 101-102 pub/220_MHZ/Auction_18/Results

On www.fcc.gov:

Rounds 1-50 pub/Auctions/220_MHZ/Auction_18/Results/R001-050
Rounds 51-100     pub/Auctions/220_MHZ/Auction_18/Results/R051-100
Rounds 101-102 pub/Auctions/220_MHZ/Auction_18/Results

Files for rounds 103-150 would continue to be uploaded to the Results directory. After round
150, the files for rounds 101-150 would be archived. The newest files, for rounds 151-200, would
be uploaded to the Results directory.  

Option 3: Tracking the Auction via the Bulletin Board System (BBS)

The FCC Auction Bulletin Board System (BBS) provides dial-in access for Auction Results.  To
access the FCC Auction BBS, use a communications package that can handle at least Xmodem
protocol (such as PcAnyWhere, Procomm, or Microsoft Terminal in Windows 3.x) to dial in to
(202) 682-5851.  Use the settings of 8 data bits, no parity and 1 stop bit (8,N,1).

Once your computer is connected to the Auction BBS, do the following:

1. To create an account:

a. Enter your first name.

b. Enter your last name.

c. When asked whether you want to create an account, enter Y.



d. When prompted, enter a password.

The password can be from four to ten characters long, where the characters can be
either letters or numbers.

e. To confirm the password, enter it again.

f. When prompted for contact information, enter your voice phone number.  Include
the area code; for example, you might enter 202-555-1234.

g. Enter your company name.

2. On the Welcome screen, enter C for Continue.  (You may also enter c, the program
accepts either case.)

Since C is the default (automatic) selection, you can also just press ENTER to continue.

3. When asked whether you want to view the bulletin menu.  Enter Y for Yes.  Then, to
continue, press ENTER to obtain the FCC Auction BBS Main Menu.

4. Enter A (for Auction Menu) to obtain the Auction Library Menu.  The top options on this
menu provide a range of numbers to represent the available auctions.

5. To select Auction 18, enter B to select the second range. 

6. On the Auctions Library Menu, enter the number of the auction you want.  Enter 8, in this
case.

The Auction Menu appears.

7. Enter A to select Announcements 
or
Enter R to select Results.

The list of available files for Auction 18 appears.  These files are sorted by date, with the
most recent files at the beginning of the list.

8. To scroll downward to the next screen of file names, either press ENTER or enter C for
Continue.  To scroll upward to the preceding screen of file names, enter P for Previous.

Note that on each screen, file names are numbered separately, starting with 1.

9. To select one or more files for downloading or viewing, mark the files you want.  The
program marks a file by preceding its name with an asterisk (*).



You can do the following:

C To mark an individual file, enter its line number.  

C To mark a range of files, enter M (for Mark) and then enter the range of files in
response to the prompt.  

For example, to mark files 6 through 12, enter 6-12 at the prompt.

C To unmark a file, enter its number again.  

You can also use Mark to unmark a range of files.

10. When you have finished marking files, download them as follows:

a. Enter D for Download.

The program displays a list that summarizes the download operation.  The Time
column lists the download time for each file; the Total Time column lists a running
total of the download times.

b. Enter D to proceed.

c. Select the file transfer protocol that has been specified in your terminal emulation
software (e.g., Xmodem or Zmodem).

When the download operation has finished, the list of files reappears.

11. Enter X to leave the BBS.

Note: All round results files will continue to be accessed through the Results menu on the BBS.
No archive menus will be created.

Announcements Files

The announcement files will use the following naming convention: aa_xxx.nn where aa is the
auction number, xxx is the round number and nn is the announcement number. For example,
18_002.07 would represent an announcement for auction eighteen that was posted during round
two and was the seventh announcement for the auction.



Round Results Files

For each round, dBase-compatible database files will be uploaded with the following naming
conventions:

18_xxxS.DBF contains all bids submitted in a particular round
18_xxxW.DBF contains all bids withdrawn in a particular round
18_xxxE.DBF contains the maximum eligibility and remaining # of waivers for each bidder
18_xxxH.DBF contains the high bids in a particular round and the minimum accepted bids
for the next round

where xxx represents the round number.

For those who cannot use the dBase-compatible database files, we will also upload the ASCII text
version of these files with the following naming conventions:

18_xxxS.TXT contains all bids submitted in a particular round
18_xxxW.TXT contains all bids withdrawn in a particular round
18_xxxE.TXT contains the maximum eligibility and remaining # of waivers for each bidder
18_xxxH.TXT contains the high bids in a particular round and the minimum accepted bids
for the next round

where xxx represents the round number.

The following file will be uploaded at the beginning of the auction to map the bidder number to
the FCC Account Number and company name:

18_XREF.DBF contains the bidder name, FCC account number and bidder number
or
18_XREF.TXT is the same file in text format

This file is used to identify which bidder is associated with each bid in the submission, withdrawal,
high bids, and bidder eligibility files.

Round Results File Formats

The Round Results File Formats will be published in a future Public Notice.



ACCESSING THE FCC NETWORK
USING WINDOWS 3.1x

This attachment describes how to access the FCC Network from a system that is running the
Microsoft Windows 3.1x operating system.  This involves using the FCC-supplied Point-to-Point
Protocol (PPP) Dialer.  

This attachment summarizes the hardware and software required for the PPP Dialer, then
describes the procedures for performing the following tasks:

C Downloading the Dialer files from the Internet or the FCC Bulletin Board System
C Installing the Dialer application
C Configuring PPP
C Establishing a PPP connection

This section also describes how to troubleshoot and uninstall the PPP Dialer application, and tells
how to get help from the FCC.

Conventions

The instructions in this section use the following typographical conventions:

bold Represents objects on the screen that you click with the mouse pointer, including
buttons, Internet links, icons, tabs, menu items (e.g., Cancel button, Auctions link,
Save option in the File menu).

italic Represents field names or areas of a screen (e.g., Applicant field, Selected Licenses
area of a screen).

bold italic Represents characters that you must type exactly as they appear in the instructions. 
For example, if you are instructed to type http://wtbwww03.fcc.gov, you should type
all of the characters shown in bold italic exactly as they are printed.

SMALL CAPS Represents keys on the keyboard (e.g., ENTER, CTRL, ESC).

Note:  Throughout these instructions, “enter” means to type the appropriate information and then
press the ENTER key.



Downloading the Dialer Software

Applicants using Microsoft Windows 3.1x should download the FCC Auctions PPP Dialer
software from either the FCC Internet Site or the FCC Bulletin Board System.  Applicants must
download the following files to install the software:

setup.exe, setup.001, setup.002

Download Method 1: Internet Access

You may use your Web browser to download the software from wtbwww01.fcc.gov or
www.fcc.gov as described in the following section.

Downloading from wtbwww01.fcc.gov:

1. Connect to your Internet service provider and start your Web browser.

2. In the Location field (Netscape 3.x), Netsite field (Netscape 4.x), or Address field 
(Internet Explorer) of the web browser screen, enter the following location:  
http://wtbwww01.fcc.gov

3. a. Click on Dialer.
b. Click on Auctions.

4. Download the following files by clicking each of the corresponding icons: 
setup.exe, setup.001, setup.002

Downloading from www.fcc.gov:

1. Connect to your Internet service provider and start your Web browser.

2. In the Location field (Netscape 3.x), Netsite field (Netscape 4.x), or Address field
(Internet Explorer) of the web browser screen, enter the following location:
http://www.fcc.gov

3. a. Click on Auctions.
b. In the Auctions section on the right, click on 220 MHz under Future.
c. Click on FCC Auctions PPP Dialer.

4. Download the following files by clicking each of the corresponding icons: 
setup.exe, setup.001, setup.002



Download Method 2: Dial-In Access to the FCC Auction Bulletin Board System (BBS):

The FCC Auction Bulletin Board System (BBS) provides dial-in access for the FCC Auctions
PPP Dialer Software.  To access the FCC Auction BBS, use a communications package that can
handle at least Xmodem protocol (such as Microsoft HyperTerminal in Windows 95,
PcAnyWhere, or Procomm) to dial in to (202) 682-5851.  Use the settings of 8 data bits, no
parity and 1 stop bit (8,N,1).

Once your computer is connected to the Auction BBS, do the following:

1. To create an account:

a. Enter your first name.

b. Enter your last name.

c. When asked whether you want to create an account, enter Y.

d. When prompted, enter a password.

The password can be from four to ten characters long, where the characters can be
either letters or numbers.

e. To confirm the password, enter it again.

f. When prompted for contact information, enter your voice phone number.  Include the
area code; for example, you might enter 202-555-1234.

g. Enter your company name.

2. On the Welcome screen, enter C for Continue.  (You may also enter c, the program
accepts either case.)

Since C is the default (automatic) selection, you can also just press ENTER to continue.

3. When asked whether you want to view the bulletin menu.  Enter Y for Yes.  Then, to
continue, press ENTER to obtain the FCC Auction BBS Main Menu.

4. Enter A (for Auction Menu) to obtain the Auction Library Menu.  The top options on this
menu provide a range of numbers to represent the available auctions.

5. To select Dialer, enter D. 



6. Enter A to select Auctions Dialer.

The list of available files appears.  These files are sorted by date, with the most recent files
at the beginning of the list.

7. To scroll downward to the next screen of file names, either press ENTER or enter C for
Continue.  To scroll upward to the preceding screen of file names, enter P for Previous.

Note that on each screen, file names are numbered separately, starting with 1.

8. To select one or more files for downloading or viewing, mark the files you want.  The
program marks a file by preceding its name with an asterisk (*).

You can do the following:

C To mark an individual file, enter its line number.  

C To mark a range of files, enter M (for Mark) and then enter the range of files in
response to the prompt.  

For example, to mark files 6 through 12, enter 6-12 at the prompt.

C To unmark a file, enter its number again.  

You can also use Mark to unmark a range of files.

Use any of these techniques to mark the following files: setup.exe, setup.001, setup.002

9. When you have finished marking files, download them as follows:

a. Enter D for Download.

The program displays a list that summarizes the download operation.  The Time
column lists the download time for each file; the Total Time column lists a running
total of the download times.

b. Enter D to proceed.

c. Select the file transfer protocol that has been specified in your terminal emulation
software (e.g., Xmodem or Zmodem).

When the download operation has finished, the list of files reappears.

10. Enter X to leave the BBS.



Installing the FCC Auctions PPP Dialer

After you have downloaded the files, you must install the FCC Auctions PPP Dialer.  To install
the software, start File Manager, open the file folder where you downloaded the files and double-
click on setup.exe. All downloaded files must be present in the file folder for the software to
install properly.

To begin, the setup program shows a screen listing the default directory to which the software
will install.  Press the Install button, then press OK to install to the specified directory.  If the
directory does not exist, the setup program will create it automatically.   

When the installation is complete, a message may appear asking you to restart Windows so that
the changes made by the installation may take effect.  Press Restart to restart Windows or press
Stay Here to restart at a later time.  Do not use the FCC Auctions PPP Dialer until you have
restarted Windows.

You will now have a new Program Manager group called FCC Auctions Dialer with icons
labeled Configure PPP, PPP Dialer, and Uninstall.

Creating Backup Installation Disks for the FCC Auctions PPP Dialer

To create backup installation disks for the FCC Auctions PPP Dialer, you will need three blank
formatted 1.44" disks. Copy setup.exe to the first disk, setup.001 to the second disk, and
setup.002 to the third disk.  

Running the Configure PPP Program

Before establishing a PPP connection, you must run the Configure PPP program.  If desired, you
may also adjust the configuration settings.

To start the Configure PPP program:

1. Double-click the Configure PPP icon.  The communications setup window appears.

2. From the Modem menu, select the COM port to which your modem is connected. 

3. From the Speed menu, select the maximum DTE rate of your modem.

For 14.4-kbps and 28.8-kbps modems, you can generally select a speed of 38400 or
57600. 

4. In most cases, carrier detect should not be checked and flow control should be checked. 
If you experience problems getting the modem to respond, experimenting with these
settings may help.



5. The DNS should be set to 165.135.22.249.

The remainder of the screen has default values which should provide optimal performance.

6. Click the Script button to bring up the Script Setup screen.  This screen gives you the
ability to issue specific commands to the modem.

7. Click the down arrow in the Selected Modem field and choose the entry from the list that
most closely matches the modem installed on your PC.

If your modem does not appear in the list, select a generic modem string by entering either
ATZ (for 14.4-kbps modems) or AT&F (for 28.8-kbps modems) in the Reset Modem
String box.

8. It may be necessary to change the command in the Modem Dial Prefix field to
accommodate how you make calls. 

For example:

Add a 1 before dialing the 800 or 900 number: ATDT1
Dialing prefix of 9 used, add a 1 before dialing the 800 or 900 number: ATDT91
Turn off call waiting, add a 1 before dialing the 800 or 900 number: ATDT*70,1

9. If you use a dialing suffix, enter it in the Dial Suffix field.

10. The default settings provided in Configure PPP should be compatible with most systems. 
If you experience problems connecting to the FCC Network, refer to the Troubleshooting
section for possible solutions.

11. When you have finished using the Configure PPP program, click the OK button.  You
may now start the FCC Auctions PPP Dialer. 

Establishing a PPP Connection

Once you have run the Configure PPP program, you can establish a PPP connection.  Do the
following:

1. To start the PPP Dialer, double-click the PPP Dialer icon in the FCC Auctions Dialer
program group. 

2. Select Non-Toll (800 service) if you want to submit an FCC Form 175 application, or



select Toll call (900 service) if you want to review FCC Form 175 applications or use the
FCC Remote Access System.

3. When the PPP Dialer establishes a connection, you will gain access to the PPP Dial Up
screen.  You may switch to the PPP Dial Up screen by pressing CTRL+ESC and
double-clicking PPP Dial Up in the Task List.

The screen will display the current status of the PPP connection.

4. Once the connection is established, open your Web browser (Netscape or Internet
Explorer).  

5. In your browser’s Location field (Netscape 3.x), Netsite field (Netscape 4.x), or Address
field (Internet Explorer), enter the appropriate Universal Resource Locator (URL) as
follows:

C For FCC Form 175 Submit, enter http://wtbwww04.fcc.gov 

C For FCC Form 175 Review or the FCC Remote Access System, enter
http://wtbwww03.fcc.gov

6. When you have finished, exit the Web browser, then switch to the PPP Dial Up screen and
select the Disconnect option from the Dial menu.

Testing the PPP Connection

1. To test the status of the PPP connection, select the Test Connection option from the Dial
menu on the PPP Dial Up screen.  This option allows you to ping the FCC Network.  The
ping process sends a signal to the FCC Network; if the signal returns, you have established
a good connection.

The Hostname box will show 165.135.22.249.

2. From the Number menu, choose the number of pings you wish to send (one, continuous,
or a user-specified number).  From the Specifications menu, you can customize the type
of request (e.g., icmp echo request), the interval between pings, and the timeout setting;
the default settings should suffice.  

If you change any of the settings and would like to save them, select the Save option from
the File menu.

3. Click the Start button.  



The status and packets boxes will display information concerning whether the pings were
returned.  

4. If necessary, click the Stop button, to end the ping process.  Click the Exit button to exit
the Ping program.

Troubleshooting

Following are problems you may encounter and possible solutions for resolving or isolating them.

Modem does not respond

1. Check the COM port setting.

2. Make sure that you have selected the appropriate modem in the Selected Modem list.  

If your modem does not appear in the list, select a generic modem string by entering either
ATZ (for 14.4-kbps modems) or AT&F (for 28.8-kbps modems) in the Reset Modem
String field.

3. Check your modem for IRQ conflicts.

4. Check the physical connections.

Modem connects but does not return an IP address

1. Check that you have selected the appropriate modem in the Selected Modem list.

2. Verify the DNS is set to 165.135.22.249.

3. Turn off VJ Compression.

4. Check your modem for IRQ conflicts.

5. Unload network drivers.

SQLSERVER errors

1. Turn off VJ Compression.

2. Unload network drivers.



3. Check for the existence of multiple winsock.dll files on your PC.

4. Test the PPP connection with the Ping program.

Errors may be caused by having multiple winsock.dll files on your PC.  To search for conflicting
winsock.dll files, start File Manager, open the directory for the root of the hard drive you want to
search (usually c:\) and select the Search option from the File menu.  In the search for: box,
enter winsock.dll.  Verify that the select all subdirectories option is selected, then click OK.

Make sure that any other winsock files are not in your path.  To check this, go to the DOS
prompt and type path.  If any directory containing another winsock.dll file appears in the path, do
either of the following:

C Temporarily rename the conflicting winsock.  

C Edit the autoexec.bat file to remove the reference to that directory, then save and reboot
the PC.  If you need to use the other PPP software package, reinsert the appropriate
directory reference, save, and reboot.

Uninstalling the FCC Auctions PPP Dialer Application

To uninstall the FCC Auctions PPP Dialer, double-click the Uninstall icon in the FCC Auctions
Dialer program group.  Click Start to uninstall the software.

Technical Support

For technical assistance with installing or using FCC software, contact the FCC Technical
Support Hotline at (202) 414-1250 (V) or (202) 414-1255 (TTY).  The FCC Technical Support
Hotline is generally available Monday through Friday, from 8 a.m. to 6 p.m. ET.  In addition, it
will be available from 9 a.m. to 5 p.m. ET, the weekend of August 15-16, 1998.  All calls to the
FCC Technical Support Hotline are recorded.



ACCESSING THE FCC NETWORK
USING WINDOWS 95

This attachment describes how to access the FCC Network from a system that is running the
Microsoft Windows 95 operating system.  This involves configuring dial-up network access and
then performing the dial-up procedure.

Conventions

The instructions in this section use the following typographical conventions:

bold Represents objects on the screen that you click with the mouse pointer, including
buttons, Internet links, icons, tabs, menu items (e.g., Cancel button, Auctions link,
Save option in the File menu).

italic Represents field names or areas of a screen (e.g., Applicant field, Selected Licenses
area of a screen).

bold italic Represents characters that you must type exactly as they appear in the instructions. 
For example, if you are instructed to type http://wtbwww03.fcc.gov, you should type
all of the characters shown in bold italic exactly as they are printed.

SMALL CAPS Represents keys on the keyboard (e.g., ENTER, CTRL, ESC).

Note:  Throughout these instructions, “enter” means to type the appropriate information and then
press the ENTER key.

Configuring Dial-Up Network Access

1. To start dial-up networking:

a. Click the Windows 95 Start button.  
b. Click the Programs option to display the Programs menu.
c. Click the Accessories option to display the Accessories menu.
d. From the Accessories menu, click Dial-Up Networking.

If Dial-Up Networking is not an option on your Accessories menu, you should install it
from your Windows 95 CD or diskettes.

2. When the Dial-Up Networking window appears, double-click the Make New Connection
icon.



3. The Make New Connection window appears.  In the field titled Type a name for the
computer you are dialing, type FCC Auctions 800# or FCC Auctions 900#. 

4. Click the down arrow at the right of the Select a modem field and select your modem from
the menu of available modems.  

If your modem does not appear on this list, you must install your modem driver according
to the modem manufacturer installation procedures, which are usually described in your
modem’s user manual.

5. Click the Next button.  

6. If you are connecting to file FCC Form 175 applications, type 800 and 378-7435 in the
Area Code and Telephone Number fields, respectively.  

If you are connecting to review FCC Form 175 applications or to use the FCC Remote
Access System, type 900 and 555-5335 in the Area Code and Telephone Number fields,
respectively.

7. Verify that the correct country is selected in the Country code field.  

If necessary, click the down arrow at the right of the Country code field and select the
appropriate country from the menu of available countries.

8. Click the Next button.

9. Click the Finish button.  

An icon labeled either FCC Auctions 800# or FCC Auctions 900# appears in the Dial-Up
Networking window.

10. Verify that properties are configured correctly before attempting a dial-up session.  Put
the mouse pointer on the appropriate Form 175 icon and click the right mouse button to
display a menu.  Click Properties from the menu.

11. Click the Configure button.  Click the Options tab at the top of the Properties window.

12. In the Connection control area of the Options tab, verify that neither option is selected.  If
either option is selected, click the check box at the left of the option to deselect it.  Then
click OK.

13. Click the Server Types button.  

14. In the Advanced Options area, verify that only Enable software compression is selected.  
If it is not selected, click the check box at the left of the option to select it.  If either of the



other options is selected, click the check box to deselect it.

15. In the Allowed Network Protocols area, verify that only TCP/IP is selected.  

If it is not selected, click the check box at the left of the option to select it.  If either of the
other options is selected, click the check box to deselect it.

16. Click the TCP/IP Settings button and select Specify name server addresses.

17. Type 165.135.22.249 as the Primary DNS.  

18. Click OK on the TCP/IP Settings window, the Server Type window, and the Properties
window.

Dial-Up Procedure

1. If the Dial-Up Networking window is not currently open, do the following:

a. Click the Windows 95 Start button.  
b. Click the Programs option to display the Programs menu.
c. Click the Accessories option to display the Accessories menu.
d. From the Accessories menu, click Dial-Up Networking.  

The Dial-Up Networking window appears.  

2. In the Dial-Up Networking window, double-click the FCC Auctions 800# or FCC
Auctions 900# icon.

Note: If you connect to the FCC’s 900 number telephone service, there is a charge of 
$2.30 per minute.  The first minute of connection time to the 900 number service is at no 
charge. 

3. Click the Connect button on the window.  Do not enter User name and Password.

The Connection window appears, indicating the status of your connection as your modem
dials into the system.  This window must remain running during your dial-up session.  You
may minimize the window, if you wish.

4. Once the connection is established, open your Web browser (Netscape or Internet
Explorer).  

5. In your browser’s Location field (Netscape 3.x), Netsite field (Netscape 4.x), or Address
field (Internet Explorer), enter the appropriate Universal Resource Locator (URL) as
follows:



C For FCC Form 175 Submit, enter http://wtbwww04.fcc.gov 

C For FCC Form 175 Review or the FCC Remote Access System, enter
http://wtbwww03.fcc.gov 

6. When you have finished, exit the Web browser, then click the Disconnect button on the
Connection window to end your dial-up session.

Troubleshooting

Following are problems you may encounter and possible solutions for resolving or isolating them.

Modem does not respond

1. Confirm that the correct modem driver is installed for your modem. 

2. Confirm that all physical connections for the modem are present.

3. Confirm that the phone line is active by connecting the modem chord to a telephone.

4. If you are dialing the 900 number service, check for a 900 number telephone block. If the 
volume settings are low, the modem may be dialing but not connecting. Check for this by 
trying to connect to the 800 number, or by dialing the 900 number on that line using a
telephone. 

 

Modem dials but does not connect

1. If you are dialing the 900 number service, check for a 900 number telephone block. Check
for this by dialing the 800 number to see if you connect, or by dialing the 900 number on
that line using a telephone. 

2. Confirm that the number the modem is dialing is correct.

3. Confirm that the modem prefix, if any, is correct.

Modem dials and connects, but nothing appears when you enter the location in the web
browser  

1. Check the settings in your dial-up networking icon, particularly that the Primary DNS is
165.135.22.249 and that TCP/IP is the only selected protocol.

2. Confirm that your web browser is using no proxies.    



3. It is recommended that you do not login to a TCP/IP Local Area Network (LAN). If you 
do login to a TCP/IP LAN, confirm that your LAN network ip address is being released.
To do so, connect to the FCC Network using dial-up networking, then click the Start
button in Windows 95 and select Run. Type winipcfg and press OK. If your ip address
does not begin with 165.135.xxx.xxx, then your LAN ip address is not being released.
Press the Release All button, or consult with your LAN administrator.

Receive an Internal Server error in the Web browser 

Confirm that javascript is enabled in your web browser.

Help

For technical assistance with installing or using FCC software, contact the FCC Technical
Support Hotline at (202) 414-1250 (V) or (202) 414-1255 (TTY).  The FCC Technical Support
Hotline is generally available Monday through Friday, from 8 a.m. to 6 p.m. ET.  In addition, it
will be available from 9 a.m. to 5 p.m. ET, the weekend of August 15-16, 1998.  All calls to the
FCC Technical Support Hotline are recorded.



AUCTION TRACKING SOFTWARE

The Commission will provide, free of charge, a stand alone tracking tool to assist bidders and
non-bidders in tracking the auction.  In the past this tool has been provided in an Excel spreadsheet
format that required users to download round results files and import them into the tracking tool
software for processing.  The Commission is investigating ways to make the tracking tool software
more efficient and effective, and hopes to have a revised tool in place before the beginning of Auction
18.  In the absence of a revised tracking tool, software resembling that used in previous auctions will
be provided.  Details will be released as soon as they are available.


